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[bookmark: _Toc2850688]ABSTRACT
The purpose of this study is to investigate the application of genetic algorithm (GA) in modelling linear and non-linear dynamic systems and develop an alternative model structure selection algorithm based on GA. Orthogonal least square (OLS), a gradient descent method was used as the benchmark for the proposed algorithm. A model structure selection based on modified genetic algorithm (MGA) has been proposed in this study to reduce problems of premature convergence in simple GA (SGA). The effect of different combinations of MGA operators on the performance of the developed model was studied and the effectiveness and shortcomings of MGA were highlighted. Results were compared between SGA, MGA and benchmark OLS method. It was discovered that with similar number of dynamic terms, in most cases, MGA performs better than SGA in terms of exploring potential solution and outperformed the OLS algorithm in terms of selected number of terms and predictive accuracy. In addition, the use of local search with MGA for fine-tuning the algorithm was also proposed and investigated, named as memetic algorithm (MA). Simulation results demonstrated that in most cases, MA is able to produce an adequate and parsimonious model that can satisfy the model validation tests with significant advantages over OLS, SGA and MGA methods. Furthermore, the case studies on identification of multivariable systems based on real experiment t al data from two systems namely a turbo alternator and a continuous stirred tank reactor showed that the proposed algorithm could be used as an alternative to adequately identify adequate and parsimonious models for those systems. Abstract must be bilingual. For a thesis written in Bahasa Melayu, the abstract must first be written in Bahasa Melayu and followed by the English translation. If the thesis is written in English, the abstract must be written in English and followed by the translation in Bahasa Melayu. The abstract should be brief, written in one paragraph and not exceed one (1) page. An abstract is different from synopsis or summary of a thesis. It should states the field of study, problem definition, methodology adopted, research process, results obtained and conclusion of the research. The abstract can be written using single or one and a half spacing. Example can be seen in Appendix 1 (Bahasa Melayu) and Appendix J (English).


[bookmark: _Toc2850689]ABSTRAK
Kajian ini dilakukan bertujuan mengkaji penggunaan algoritma genetik (GA)
dalam pemodelan sistem dinamik linear dan tak linear dan membangunkan kaedah alternatif bagi pcmilihan struktur model menggunakan GA. Algorithma kuasa dua terkecil ortogon (OLS), satu kaedah penurunan kecerunan digunakan sebagai bandingan bagi kaedah yang dicadangkan. Pcmilihan struktur model mengunakan kaedah algoritma genetik yang diubahsuai (MGA) dicadangkan dalam kajian ini bagi
mengurangkan masalah konvergens pramatang dalam algoritma genetik mudah (SGA). Kesan penggunaan gabungan operator MGA yang berbeza ke atas prestasi model yang terbentuk dikaji dan keberkesanan serta kekurangan MGA diu t arakan. Kajian simulasi dilakukan untuk membanding SGA, MGA dan OLS. Dengan meggunakan bilangan parametcr dinamik yang setara kajian ini mendapati, dalam kebanyakan kes, prestasi MGA adalah lebih baik daripada SGA dalam mencari penyelesaian yang berpotensi dan lebih berkebolehan daripada OLS dalam menentukan bilangan sebutan yang dipilih dan ketcpatan ramalan. Di samping itu, penggunaan carian tcmpatan dalam MGA untuk menambah baik algorithma tersebut dicadang dan dikaji, dinamai sebagai algoritma mcmetic (MA). Hasil simulasi menunjukkan, dalam kebanyakan kes, MA berkeupayaan menghasilkan model yang bersesuaian dan parsimoni dan mcmenuhi ujian pengsahihan model di samping mcmperolehi beberapa kelebihan dibandingkan dengan kaedah OLS, SGA dan MGA. Tambahan pula, kajian kes untuk sistcm berbilang pcmbolehubah menggunakan data eksperimental sebenar daripada dua sistem iaitu sistem pengulang-alik turbo dan reaktor teraduk berterusan menunjukkan algoritma ini boleh digunakan sebagai alternatif untuk mcmperolehi model termudah yang memadai bagi sistcm tersebut.
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INTRODUCTION
[bookmark: _Toc2850697]Introduction
Video provides a powerful way to help you prove your point. When you click Online Video, you can paste in the embed code for the video you want to add. You can also type a keyword to search online for the video that best fits your document. To make your document look professionally produced, Word provides header, footer, cover page, and text box designs that complement each other. For example, you can add a matching cover page, header, and sidebar. “For the first paragraph, use ‘Para 2 lines’ style”
Video provides a powerful way to help you prove your point. When you click Online Video, you can paste in the embed code for the video you want to add. You can also type a keyword to search online for the video that best fits your document. To make your document look professionally produced, Word provides header, footer, cover page, and text box designs that complement each other. For example, you can add a matching cover page, header, and sidebar. Click Insert and then choose the elements you want from the different galleries. Themes and styles also help keep your document coordinated. When you click Design and choose a new Theme, the pictures, charts, and SmartArt graphics change to match your new theme. “For the last paragraph/single paragraph in the section, use ‘Para 4 lines’ style”
[bookmark: _Toc2850698]Problem Background
Video provides a powerful way to help you prove your point. When you click Online Video, you can paste in the embed code for the video you want to add. You can also type a keyword to search online for the video that best fits your document. To make your document look professionally produced, Word provides header, footer, cover page, and text box designs that complement each other. For example, you can add a matching cover page, header, and sidebar. Click Insert and then choose the elements you want from the different galleries.
Themes and styles also help keep your document coordinated. When you click Design and choose a new Theme, the pictures, charts, and SmartArt graphics change to match your new theme. When you apply styles, your headings change to match the new theme. Save time in Word with new buttons that show up where you need them. To change the way a picture fits in your document, click it and a button for layout options appears next to it. When you work on a table, click where you want to add a row or a column, and then click the plus sign.
[bookmark: _Toc2850699]Project Aim
Project aim shows what you plan to achieve in one sentence.
[bookmark: _Toc2850700]Project Objectives
The objectives of the project are:
To estimate the parameters 
Item 1
Item 2
To define the best parameter estimate.

[bookmark: _Toc2850701]Project Scope
The scopes of the project are:
Scope 1
Scope 2
1.1 [bookmark: _Toc2850702]Project Importance
Themes and styles also help keep your document coordinated. When you click Design and choose a new Theme, the pictures, charts, and SmartArt graphics change to match your new theme. When you apply styles, your headings change to match the new theme. Save time in Word with new buttons that show up where you need them. To change the way a picture fits in your document, click it and a button for layout options appears next to it. When you work on a table, click where you want to add a row or a column, and then click the plus sign.
[bookmark: _Toc2850703]Report Organization
Themes and styles also help keep your document coordinated. When you click Design and choose a new Theme, the pictures, charts, and SmartArt graphics change to match your new theme. When you apply styles, your headings change to match the new theme. Save time in Word with new buttons that show up where you need them. To change the way a picture fits in your document, click it and a button for layout options appears next to it. When you work on a table, click where you want to add a row or a column, and then click the plus sign.
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LITERATURE REVIEW
[bookmark: _Toc2850705]Introduction 
Video provides a powerful way to help you prove your point. When you click Online Video, you can paste in the embed code for the video you want to add. You can also type a keyword to search online for the video that best fits your document. To make your document look professionally produced, Word provides header, footer, cover page, and text box designs that complement each other. For example, you can add a matching cover page, header, and sidebar.
[image: ]
[bookmark: _Toc2850749]Figure 2.1	Continuous variability reduction using SPC chart (Revelle and Harrington, 1992)
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[bookmark: _Toc2850745]Table 2.2	Regression analysis for the results of preliminary feature screening
[bookmark: _Toc2850746]Table 2.3	Estimated effects and regression coefficients for the recogniser's performance (reduced model)
Video provides a powerful way to help you prove your point. When you click Online Video, you can paste in the embed code for the video you want to add. You can also type a keyword to search online for the video that best fits your document. To make your document look professionally produced, Word provides header, footer, cover page, and text box designs that complement each other. For example, you can add a matching cover page, header, and sidebar.
[bookmark: _Toc2850706]Case Study (If any)
Study of domain from general to specific, related studies, a description of the identified problem.
[bookmark: _Toc2850707]Company Organization Structure
Video provides a powerful way to help you prove your point. When you click Online Video, you can paste in the embed code for the video you want to add. You can also type a keyword to search online for the video that best fits your document. To make your document look professionally produced, Word provides header, footer, cover page, and text box designs that complement each other. For example, you can add a matching cover page, header, and sidebar.

[bookmark: _Toc2850708]Manual Operation
After deliberating on doctoral education in Australia in the 1990s, one observer I Australia writes:
The lack of any significant formal course work within our Ph.D. and master degrees by research has continued for three decades. The focus of our Ph.D. research type degrees continues to be the research project, and this is almost the only medium by which education is accomplished.
(Stranks, 1984:171)

1.2 [bookmark: _Toc2850709]Current System Analysis
Study of theory/algorithm/method that can contribute towards solving the problem, Justification of chosen theory/algorithm/method, Every sub-topic within the domain must have a review.
	

	(2.1)


To change the way a picture fits in your document, click it and a button for layout options appears next to it. When you work on a table, click where you want to add a row or a column, and then click the plus sign. Reading is easier, too, in the new Reading view. You can collapse parts of the document and focus on the text you want. If you need to stop reading before you reach the end, Word remembers where you left off - even on another device. Video provides a powerful way to help you prove your point. When you click Online Video, you can paste in the embed code for the video you want to add. You can also type a keyword to search online for the video that best fits your document. To make your document look professionally produced, Word provides header, footer, cover page, and text box designs that complement each other. For example, you can add a matching cover page, header, and sidebar.
[bookmark: _Toc2850710]Comparison between existing systems
Video provides a powerful way to help you prove your point. When you click Online Video, you can paste in the embed code for the video you want to add. You can also type a keyword to search online for the video that best fits your document. To make your document look professionally produced, Word provides header, footer, cover page, and text box designs that complement each other. For example, you can add a matching cover page, header, and sidebar.

[bookmark: _Toc2850711]Literature Review of Technology Used
Video provides a powerful way to help you prove your point. When you click Online Video, you can paste in the embed code for the video you want to add. You can also type a keyword to search online for the video that best fits your document. To make your document look professionally produced, Word provides header, footer, cover page, and text box designs that complement each other. For example, you can add a matching cover page, header, and sidebar.

[bookmark: _Toc2850712]Chapter Summary
Video provides a powerful way to help you prove your point. When you click Online Video, you can paste in the embed code for the video you want to add. You can also type a keyword to search online for the video that best fits your document. To make your document look professionally produced, Word provides header, footer, cover page, and text box designs that complement each other. For example, you can add a matching cover page, header, and sidebar.
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SYSTEM DEVELOPMENT METHODOLOGY
[bookmark: _Toc2850714]Introduction
On the Insert tab, the galleries include items that are designed to coordinate with the overall look of your document. You can use these galleries to insert tables, headers, footers, lists, cover pages, and other document building blocks. When you create pictures, charts, or diagrams, they also coordinate with your current document look. You can easily change the formatting of selected text in the document text by choosing a look for the selected text from the Quick Styles gallery on the Home tab.
[bookmark: _Toc2850715]Methodology Choice and Justification
On the Insert tab, the galleries include items that are designed to coordinate with the overall look of your document. You can use these galleries to insert tables, headers, footers, lists, cover pages, and other document building blocks. When you create pictures, charts, or diagrams, they also coordinate with your current document look. You can easily change the formatting of selected text in the document text by choosing a look for the selected text from the Quick Styles gallery on the Home tab.
[bookmark: _Toc2850716]Phases of the Chosen Methodology 
On the Insert tab, the galleries include items that are designed to coordinate with the overall look of your document. You can use these galleries to insert tables, headers, footers, lists, cover pages, and other document building blocks. When you create pictures, charts, or diagrams, they also coordinate with your current document look. You can easily change the formatting of selected text in the document text by choosing a look for the selected text from the Quick Styles gallery on the Home tab.
[bookmark: _Toc2850717]Technology Used Description
On the Insert tab, the galleries include items that are designed to coordinate with the overall look of your document. You can use these galleries to insert tables, headers, footers, lists, cover pages, and other document building blocks.

[image: ]
[bookmark: _Toc2850750]Figure 3.1	Example of Formatting Method

[bookmark: _Toc2850718]System Requirement Analysis
Video provides a powerful way to help you prove your point. When you click Online Video, you can paste in the embed code for the video you want to add. You can also type a keyword to search online for the video that best fits your document. To make your document look professionally produced, Word provides header, footer, cover page, and text box designs that complement each other. For example, you can add a matching cover page, header, and sidebar.

[bookmark: _Toc2850719]Chapter Summary
Video provides a powerful way to help you prove your point. When you click Online Video, you can paste in the embed code for the video you want to add. You can also type a keyword to search online for the video that best fits your document. To make your document look professionally produced, Word provides header, footer, cover page, and text box designs that complement each other. For example, you can add a matching cover page, header, and sidebar.
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REQUIREMENT ANALYSIS AND DESIGN
[bookmark: _Toc2850721]Introduction
Video provides a powerful way to help you prove your point. When you click Online Video, you can paste in the embed code for the video you want to add. You can also type a keyword to search online for the video that best fits your document.

[bookmark: _Toc2850722]Requirement Analysis
Video provides a powerful way to help you prove your point. When you click Online Video, you can paste in the embed code for the video you want to add. You can also type a keyword to search online for the video that best fits your document.

[bookmark: _Toc2850723]Project Design
Video provides a powerful way to help you prove your point. When you click Online Video, you can paste in the embed code for the video you want to add. You can also type a keyword to search online for the video that best fits your document.

[bookmark: _Toc2850724]Database Design
Video provides a powerful way to help you prove your point. When you click Online Video, you can paste in the embed code for the video you want to add. You can also type a keyword to search online for the video that best fits your document.

[bookmark: _Toc2850725]Interface Design 
Video provides a powerful way to help you prove your point. When you click Online Video, you can paste in the embed code for the video you want to add. You can also type a keyword to search online for the video that best fits your document.

[bookmark: _Toc2850726]Chapter Summary
Video provides a powerful way to help you prove your point. When you click Online Video, you can paste in the embed code for the video you want to add. You can also type a keyword to search online for the video that best fits your document.
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[bookmark: _Toc2850747]Table 4.1	Regression analysis for the results of preliminary feature screening
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IMPLEMENTATION AND TESTING
[bookmark: _Toc2850728]Introduction
Video provides a powerful way to help you prove your point. When you click Online Video, you can paste in the embed code for the video you want to add. You can also type a keyword to search online for the video that best fits your document. To make your document look professionally produced, Word provides header, footer, cover page, and text box designs that complement each other. For example, you can add a matching cover page, header, and sidebar.

[bookmark: _Toc2850729]Coding of System Main Functions
Video provides a powerful way to help you prove your point. When you click Online Video, you can paste in the embed code for the video you want to add. You can also type a keyword to search online for the video that best fits your document. To make your document look professionally produced, Word provides header, footer, cover page, and text box designs that complement each other. For example, you can add a matching cover page, header, and sidebar.

[bookmark: _Toc2850730]Interfaces of System Main Functions
Video provides a powerful way to help you prove your point. When you click Online Video, you can paste in the embed code for the video you want to add. You can also type a keyword to search online for the video that best fits your document. To make your document look professionally produced, Word provides header, footer, cover page, and text box designs that complement each other. For example, you can add a matching cover page, header, and sidebar.

[bookmark: _Toc2850731]Testing
Video provides a powerful way to help you prove your point. When you click Online Video, you can paste in the embed code for the video you want to add. You can also type a keyword to search online for the video that best fits your document. To make your document look professionally produced, Word provides header, footer, cover page, and text box designs that complement each other. For example, you can add a matching cover page, header, and sidebar.
[bookmark: _Toc2850732]Black box Testing
Video provides a powerful way to help you prove your point. When you click Online Video, you can paste in the embed code for the video you want to add. You can also type a keyword to search online for the video that best fits your document. To make your document look professionally produced, Word provides header, footer, cover page, and text box designs that complement each other. For example, you can add a matching cover page, header, and sidebar.
[bookmark: _Toc2850733]System Flow
Video provides a powerful way to help you prove your point. When you click Online Video, you can paste in the embed code for the video you want to add. You can also type a keyword to search online for the video that best fits your document. To make your document look professionally produced, Word provides header, footer, cover page, and text box designs that complement each other. For example, you can add a matching cover page, header, and sidebar.
[bookmark: _Toc2850734]Input Output Verification
Video provides a powerful way to help you prove your point. When you click Online Video, you can paste in the embed code for the video you want to add. You can also type a keyword to search online for the video that best fits your document. To make your document look professionally produced, Word provides header, footer, cover page, and text box designs that complement each other. For example, you can add a matching cover page, header, and sidebar.
1.2.1.1 [bookmark: _Toc2850735]Error Messages
Video provides a powerful way to help you prove your point. When you click Online Video, you can paste in the embed code for the video you want to add. You can also type a keyword to search online for the video that best fits your document. To make your document look professionally produced, Word provides header, footer, cover page, and text box designs that complement each other. For example, you can add a matching cover page, header, and sidebar.
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Video provides a powerful way to help you prove your point. When you click Online Video, you can paste in the embed code for the video you want to add. You can also type a keyword to search online for the video that best fits your document. To make your document look professionally produced, Word provides header, footer, cover page, and text box designs that complement each other. For example, you can add a matching cover page, header, and sidebar.

1.2.2 [bookmark: _Toc2850737]User Testing
Video provides a powerful way to help you prove your point. When you click Online Video, you can paste in the embed code for the video you want to add. You can also type a keyword to search online for the video that best fits your document. To make your document look professionally produced, Word provides header, footer, cover page, and text box designs that complement each other. For example, you can add a matching cover page, header, and sidebar.
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Video provides a powerful way to help you prove your point. When you click Online Video, you can paste in the embed code for the video you want to add. You can also type a keyword to search online for the video that best fits your document. To make your document look professionally produced, Word provides header, footer, cover page, and text box designs that complement each other. For example, you can add a matching cover page, header, and sidebar.
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CONCLUSION
2.1 [bookmark: _Toc2850740]Introduction
Video provides a powerful way to help you prove your point. When you click Online Video, you can paste in the embed code for the video you want to add. You can also type a keyword to search online for the video that best fits your document. To make your document look professionally produced, Word provides header, footer, cover page, and text box designs that complement each other. For example, you can add a matching cover page, header, and sidebar.
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